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FOREWORD

«I wish to set up my own website, my own way. I'd like to invest no money at all.
Where can I start from? And how can I do that?»

This ebook provides an answer to all these questions.

We are not going to use neither Office Word nor WordPress, not even specialised sites
such as "1and1":  our website  shall  be  precisely as we imagine  it,  without  using
"templates" and with no locked graphical solutions. Text blocks and images shall be
placed  just  where we wish  them to be,  not  courtesy  of  the  tool  we  make use  of.
Because this is our site and we want to create it the way we like it.

In addition, we wish to introduce changes in our website, when and where we want
to.  We want  to be given a full  "hand-on" capability,  in  total  freedom and without
asking for permission to anybody.

We want our site to be properly rendered on a PC, on a smartphone, and on any
other handheld device like a tablet. And we want to be in full control as to what to
render, and how.

Finally, we want to spend no money. In fact our site is just the very beginning of a
personal journey across the web: if revealing itself a success, then - and then only - we
will invest our money in it.

«Yet I definitely am not a computer nerd! How can I achieve all that?»

Sure you can! We will achieve that together with a step-by-step approach, keeping the
tech jargon to a minimum and sticking to the essential, with extensive use of "cut and
paste" operations from this guidebook.

So, no programming classes: by cutting and pasting code chunks, everybody will be
able to build up their own site, right now and with no need for further insight, by
simply learning how to place text blocks and pictures where it is required within the
web page.

From a  technical  standpoint,  we  will  design  a  very  simple  website,  including  no
HTML tricks, advanced CSS formatting and complex Javascript coding. And yet, our
site will be ideal for showcasing and spreading our views or selling a product or
service,  without  turning  to  expensive  business  services  for  web  development  and
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management.

All the examples and methods presented in this ebook are easily replicated at will: you
will be able to customise all the available code chunks to create your own site,
with your graphical settings, your preferred images and your edited text: you will just
have to change the instance code provided in the ebook, pasting it where you wish,
and you will achieve all your goals!

So let's start creating together our own website!
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1. WHERE TO PLACE YOUR SITE IN THE WEB
 

To begin with, we must select a place in the web where to store our site.

A simple and easy solution is  Freewha (Free Web Hosting Area), a web space that
provides free hosting services featuring no compulsory advertisement. In the future,
we may decide to easily move our site to more advanced web hosting services, such as
"HostGator" or "1and1".

To  register  our  new  website,  for  instance  with  the  name  www.mywebsite-
atlast.orgfree.com, perform the following steps:

• in your browser, go to the site www.freewha.com
• in  the  "Free  subdomain  hosting"  box,  insert  your  desired  name,  for  instance

'mywebsite-atlast' (with no quotes), then select the subdomain name 'orgfree.com' and
press the "PROCEED" button

• in the next screenshot, insert a valid email address and choose a password
• tick the service agreement terms checkbox and press the "CREATE" button

A welcome page will be displayed with all the information you need for use in the next
chapter  (important  notice:  copy  the  info  shown  under  the  "Your  Personal  FTP
Information" headline, we are going to use it very soon!)
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Now the web space for the new site www.mywebsite-atlast.orgfree.com is already up
and running. Try and insert the name of your new site in your browser: a standard page
will appear with the message "New Account, upload your files!"

We are not going to use the tools provided by Freewha in their panel. We will work
with a set of tools of our choice. So for the time being let's leave the Freewha site and
proceed right to the next step: how to communicate with our new site.
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2. HOW TO SEND FILES TO YOUR WEBSITE
 

The second step is to download from the web an application establishing a link to our
new site for file upload.

A most popular free communications software is  CoreFTP,  an application that can
easily transfer files from our local PC to our website, and the other way round as well.

To download CoreFTP, we must carry out the following steps:

• connect to www.coreftp.com
• click "Download Core FTP now"
• under the heading "Core FTP - free version", click "www.coreftp.com" (select 64bit o

32bit according to the operating system already installed on your PC)
• when the download of the .exe application is over, click it to start the installation
• click "I agree" in the License Agreement screenshot
• click "Next" in the subsequent screenshot and then "Install"

Now CoreFTP is ready for use. You will  only need to configure the application to
establish a communication link to our new website.

Let's  start  CoreFTP by clicking the icon now positioned on our desktop.  Open the
"File" menu (in the top-left corner), then select "Connect" e finally press the "New
Site" button. The mask shown in the following figure will pop up: we must fill it in
with  the  access  data  that  we  got  from  Freewha  in  their  welcome  screen  ("Your
Personal FTP Information" section).
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In  this  example  we  have  entered  the  info  pertaining  to  our  test  website
www.mywebsite-atlast.orgfree.com. For your personal site, you will have to enter the
specific name you have defined in Freewha.

Now press the "Connect" button located at the bottom: CoreFTP will connect your PC
to your new website. You can now talk to your site and upload to it all the files you
want!

In your local PC, create a new folder (you may use the same name as that of your new
website): in it you will store all the files to be uploaded to your website.

A last step: in CoreFTP, find the small icon shaped as a driver and click it, then select
the driver and folder on your PC that you have just created for storage. CoreFTP will
present you a screenshot similar to the following one:
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Now you are ready to perform your first file transfer from your PC (on the screen's left
side) to your new website (on the screen's right side, where you can see a number of
files already present, provided by Freewha).

So let's try and upload our first file to our new site.
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3. HOW TO UPLOAD INDEX.HTML TO YOUR SITE
 

We are now going to replace Freewha's "hostindex.html" file with our new file, named
"index.html".

All the files mentioned in this ebook (with the exception of images) will be edited with
a very simple application: old good Windows Notepad, the free text editor available on
all PCs.

To open Notepad, click the Windows start menu button (bottom-left corner on your
PC's screen) and write "Notepad" in the "Search programs and files" box. When the
search is over, click the "Notepad" icon and open the editor.

We will use Notepad to write our website's first homepage, creating an "index.html"
file. Copy the code presented in the box below and paste it to the Notepad editor:

Code to be copied to index.html

<!DOCTYPE html>
<html lang="en">
<head>
<title>My website at last!</title>
<meta charset="utf-8">
<meta name="description" content="The site made with my 
hands, the way I want and at absolutely no costs">
<meta name="author" content="my name">
<meta name="viewport" content="width=device-width, 
initial-scale=1.0" />
</head>
<body>
<span>Ladies and gentlemen... MY NEW WEBSITE!</span>
</body>

Now save your Notepad file: open the "File" drop-down menu, select "Save as" and
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save the text file in a new folder to be created in your local PC for storage purposes.
You have to name the file exactly "index.html" (without quotes and capital letters),
otherwise your site will not work!

Time has come to send your "index.html" file to your new website. Open CoreFTP
(connect again to your site if your connection was shut down meanwhile; to re-connect
you may use the "Reconnect" button shown on the top-left corner of the CoreFTP's
screen) and select your storage folder in your local PC (left screen) using the driver
icon.

In the left-side screen, click the file "index.html" once so as to select it. Then, find the
icon with a small arrow ("upload") highlighted in the figure below with a red circle
and...

... click it: your "index.html" file will be thrust across the web towards your site and
will instantly reach it, popping up in CoreFTP's right-side screen.

You have just created your first homepage ever. In fact, if you now connect to your site
(in our example  www.mywebsite-atlast.orgfree.com) with your browser, you will see
the  following  text  on  your  homepage:  "Ladies  and  gentlemen...  MY  NEW
WEBSITE!"
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Warning... You must be aware that you have already established your full presence in
the World Wide Web: your new homepage is now visible from all over the world!

Your "index.html" file is now ready to be stuffed with all the content you wish. Close
the file for the time being. To re-open it, you must right-click it with the mouse, select
"Open with..." and pick "Notepad" as opening application (please note that if you just
double-click  it,  your  "index.html"  will  open  in  your  predefined  browser,  with  no
chance to edit it).

Before proceeding further, we just get rid of all Freewha files in the website that are of
no use for us:  cancel "403.html",  "favicon.ico",  "hostindex.html",  "README.html"
and  "robots.txt"  and  the  subfolder  "images"  by  simply  selecting  them  all  in  the
CoreFTP right-side screen and then pressing the "Canc" key. When you are finished,
the view will be much cleaner, with only your new "index.html" file and a system file
(".ftpquota") to be seen.

The next step is to edit a second file, one of primary importance for your site (the first
one was "index.html"): this is the file containing all graphic info, "stylesheet.css", the
fundamental  tool to gain full control  of  your site's  design (selection of colors,  text
block formatting, image location, etc.)

Chapter 4 and Chapter 5
are not included
in this preview
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6. MAKE YOUR PICTURES UNIQUE AND 
UNRIVALLED
 

We need an application to edit, color and merge at will the pictures we plan to use in
our site, in a view to making our web pages attractive and challenging.

Sure  enough,  we  have  no  intention  to  purchase  any  expensive  professional  tools.
Instead, we are going to use a powerful freeware: Paint.NET. As you will find out
yourself, by using this program we will be able to do everything we want with pictures
to create a truly original website.

Connect to the Paint.NET site. To download the latest version of the program click on
the top-right side of the screen under the heading "Get it now (free download)". In the
next screenshot, click the icon "Download Now - dotPDN", download the installer and
launch the compessed .zip file to install Paint.NET on your local PC.

When the installation is completed, open Paint.NET: in the program's main page, click
the  "Open  file"  icon  on  the  top-left  side  of  the  screen  and  select  the
"Homepage_image.jpg" file which you had saved in your "PCimages" subfolder. Our
picture of New York is now displayed with the Paint.NET program: we can go and
change it the way we want.

To  begin  with,  let's  enhance  the  colors  of  our  picture:  open  the  drop-down  menu
"Adjustments"  and  click "Hue/Saturation".  Increase  the  saturation  by dragging  the
control  slider up to "115":  now our homepage image will  prove more colored and
charming.
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Now we must resize the picture to a width of 1366 pixels (i.e. the width of a laptop's
screen): open the drop-down menu "Image" and select "Resize". Be sure that the "By
absolute size" and "Maintain aspect ratio" checkboxes are ticked, then type "1366" in
the "Width" box and press "OK". The picture will resize to fit the standard width of
laptop screens.
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Now the issue is that the resulting picture is too high, so we have to select a strip of it
with a smaller height. Open the tool list on the top-left side of the screen and pick the
"Rectangle Select" tool.

Now position the cursor shaped as a "+" to the far-left side of the New York picture,
just slightly below the top side of the image: while pressing your mouse's left button,
drag the cursor across the image to its far right, so as to select a wide strip of the
picture (highlighted by the dotted lines, as visible in the image below).
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You can select the strip you like the most (the strip's height must be smaller of the
screen's height: as to our New York picture, we defined a 548-pixel height, you can do
the same by checking the strip's actual height in the bottom-left message area "Size of
rectangle selection"). Finally, copy the selected strip by opening the "Edit" drop-down
menu and clicking "Copy".

And now let's create our new homepage image: paste the copied strip by opening the
"Edit" drop-down menu and selecting "Paste into New Image".
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Finally we save the picture by opening the "File" drop-down menu and selecting "Save
As...": store it with the name "Homepage_image_OK.jpg" next to the already existing
"Homepage_image.jpg" file.

Now we are ready to upload our new cover image to the website's homepage. We will
also create the site's title and display our first text boxes and pictures.

Chapter 7 and Chapter 8
are not included
in this preview
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9. TEXT, PICTURES AND LINKS
 

Let's improve our homepage by including more text and pictures.

Connect once more to Pixabay.com to find a new image. In our example we will use a
picture showing yellow cabs in New York, but you are free to pick any image you like
the most. Download it to the "PCimages" folder with the name "Cab_image.jpg" and -
with  the  help  of  Paint.NET -  resize  it  to  500  x  300  pixels.  Then  send  it  to  the
"WEBimages" folder in our website using CoreFTP.

Now, in "index.html" and "stylesheet.css", copy the following instructions (right below
the codes we included earlier in the two files), save the files and send them to our
website with CoreFTP:

Code to be copied to index.html

<div id="Image_box3"> <img class="aligncenter size-full"
title="A journey across the web" 
src="../WEBimages/Cab_image.jpg" > </div>

Code to be copied to stylesheet.css

#Image_box3 {
float:left;
margin:0;
padding:0;
position:absolute;
overflow:visible;
left:750px;
top:565px;
background:none;
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border:none;
}

By refreshing your homepage in  the browser,  the image with  the yellow cabs will
properly appear (this time with no background box):

Now we are going to add a text block below the new image. Copy the following code
to "index.html" e "stylesheet.css",then save both files and send them across the web
with CoreFTP as usual:

Code to be copied to index.html

<div id="Text3">
<span>Many people believe they will never be able to 
build up a website with their own hands. This is not how
things should be looked upon: everybody can design their
own site, including pictures and text in any position 
and with any format they wish, with no need to purchase 
expensive commercial programs nor complex content 
management systems. It is just a matter of using a few 
simple code chunks, freely available application 
software and a bit of imagination... and everything 
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becomes easy!</span>
</div>

Code to be copied to stylesheet.css

#Text3 {
position: absolute;
left:760px;
top:880px;
width:480px;
font-family: 'Lora';
font-size: 16px;
font-weight: 400;
line-height: 120%;
text-align: justify;
color: #C6FFC6;
}

Here is the resulting screenshot:
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Now let's try to connect the yellow cab picture and its text block to a new webpage (an
external page or a subpage in our website).

In  the  "index.html"  file,  replace  the  "Image_box3"  code  we just  inserted  with  the
following code:

Code to copied to index.html

<div id="Image_box3"> <a href="http://www1.nyc.gov/"> 
<img class="aligncenter size-full" title="A journey 
across the web" src="../WEBimages/Cab_image.jpg" 
style="border-style:none"></a> </div>

Then click the  cab image in  your  browser:  you will  jump to the  New York City's
official website.

What if we wish to link our text block to a new subpage in our website? First, copy the
"index.html" file to a new file whose name is "subpage.html". Open the new file with
Notepad, delete all instruction code between <body> and </body> and, right below the
instruction <body>, paste the following code:

The remaining part of Chapter 9,
Chapter 10, Chapter 11, Chapter 12 and Chapter 13 

are not included
in this preview
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14. IMPROVING YOUR SITE: DROP-DOWN MENUS
WITH JAVA
 

As an interesting example, we are going to illustrate a smart effect which is based on a
Java script: a drop-down menu that opens and closes automatically by just moving the
mouse across it.

Let's start designing the menu. Open the "index.html" and "stylesheet.css" files and
insert the following code (just before the footer instructions we have already included),
then save both files and send them to your website with CoreFTP:

Code to be copied to index.html

<div id="Menu2">
<span></span>
</div>

<div id="Menu2_text1">
<span>How to build up a website with your own 
hands</span>
</div>

<div id="Menu2_image"> <img class="aligncenter size-
full" src="../WEBimages/Image_6.jpg" > </div>

<div id="Menu2_text2">
<span>A simple, comprehensive ebook that explains how to
create and publish your personal website, with the 
graphic design you want and <a href="subpage.html" 
style="color:#0B1AC1;font-weight:bold;text-
decoration:underline">whose cost is absolutely 
nought"</a></span>
</div>
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Code to be copied to stylesheet.css

#Menu2 {
position: absolute;
left:116px;
top:50px;
width:370px;
height:340px;
background: #FFE1B7;
z-index:10;
visibility:visible;
}

#Menu2_text1 {
position: absolute;
left:116px;
top:63px;
width:370px;
font-family: 'Lobster';
font-size: 20px;
font-weight: bold;
text-align: center;
color: #6235C4;
z-index:10;
visibility:visible;
}

#Menu2_image {
float:left;
margin:0;
padding:0;
position:absolute;
overflow:visible;
left:150px;
top:100px;
background:none;
border:none;
z-index:10;
visibility:visible;
}

#Menu2_text2 {
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position: absolute;
left:124px;
top:310px;
width:350px;
font-family: 'Lora';
font-size: 14px;
font-weight: normal;
font-style: italic;
text-align: center;
color: #000000;
z-index:10;
visibility:visible;
}

If you save it all and transfer both files to your site via CoreFTP, after refreshing your
homepage in the browser, you will see that just below the "Who we are" button a drop-
down  menu is  now shown,  with  a  heading,  a  picture,  a  text  block  and  an  active
hyperlink.
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However, the drop-down menu we just designed is always visible. How can we make
it visible only when the cursor travels across the "Who we are" heading?

First, take the code we have just inserted in "stylesheet.css" and replace the four words
"visible" with the word "hidden" (save the file once again and send it via CoreFTP).
Now the new drop-down menu has vanished, as it is not visible anymore under normal
conditions.

Then, in "index.html", look for the code line which defines the heading "Who we are"
(<div id="Text_button2">), delete and replace it with the following code:

Code to copy to index.html

<div id="Text_button2" onmouseover="Script_java_button2()">

Again, in "index-html", look for the code line which defines the cover image of New
York (<div id="Cover_image">), delete and replace it with the following code:

Code to copy to index.html

<div id="Cover_image" 
onmouseover="Script_java_deleteall()">

One more time, in "index-html", look for the code line which defines the site's title
(<div id="Site_title">), delete and replace it with the following code:

Code to copy to index.html

<div id="Site_title" 
onmouseover="Script_java_deleteall()">

And finally go to the initial part of your "index.html" file. Just before the instruction
</head>, insert the following code:
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Code to copy to index.html

<script>
function Script_java_button2() {
document.getElementById("Menu2").style.visibility="visible";
document.getElementById("Menu2_text1").style.visibility="visible";
document.getElementById("Menu2_image").style.visibility="visible";
document.getElementById("Menu2_text2").style.visibility="visible";
}

function Script_java_deleteall() {
document.getElementById("Menu2").style.visibility="hidden";
document.getElementById("Menu2_text1").style.visibility="hidden";
document.getElementById("Menu2_image").style.visibility="hidden";
document.getElementById("Menu2_text2").style.visibility="hidden";
}
</script>

Save the "index.html" file and send it to our website with CoreFTP so as to see what
effects are now visible in our browser.

You  will  see  that  the  drop-down  menu  we  had  previously defined,  now normally
hidden,  pops  up  when  our  mouse  moves  across  the  "Who  we  are"  button  and
disappears when the mouse travels across the neighbouring areas (the picture of New
York, the website's title).

The above is but an example, but it's crystal-clear how wide the collection of effects
you might produce by usign a Java  script  can be.  If  you apply this method to  all
website buttons, the user navigation experience will get more attractive and unique.
With a little bit of trials and errors, you will be able to implement additional effects at
will.
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15. YOUR WEBSITE FOR SMARTPHONE
 

We  complete  this  comprehensive  ebook  with  additional  information  on  how  to
configure our website so as to have it correctly displayed on smartphones and other
devices.

How can we render our site "responsive" to the device where it is displayed on? How
can be adapt the site visualisation according to the user terminal?

To begin with,  we must  configure our website so as to become aware whether it's
being displayed on a screen as large as 1366 x 768 pixels (a typical laptop screen size;
the iPad uses a screen as large as 2048 x 1536 pixels) or on a smaller screen like the
ones commonly implemented in smartphones (the iPhone has a screen ranging from
320 x 380 pixels in older models up to 414 x 736 in the latest models).

To achieve responsiveness, open the "index.html" and - after the instruction  <link
rel="stylesheet" type="text/css" href="stylesheet.css" />,
add the following code:

Code to be copied to index.html

<link rel="stylesheet" type="text/css" media="only 
screen and (max-device-width: 800px)" 
href="stylesheet_smartphone.css" />

Save the file and send it to our site through Core FTP.

Now  take  our  "stylesheet.css"  file  and  copy  it  to  a  new  file  named
"stylesheet_smartphone.css".  Open  this  new  file  with  Notepad,  find  the  code  line
background: #0000AA;, delete and replace it with the following code:
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Code to be copied to stylesheet_smartphone.css

background: #AA0000;

Save "stylesheet_smartphone.css" too and send it to the website with Core FTP.

You  can  see  the  effect  that  our  changes  induce  in  the  website  by  refreshing  the
homepage in  our  browser,  and then on our smartphone:  on the  PC screen the  site
background  will  be  blue  as  usual;  yet  if  we  display  the  same  homepage  on  our
smartphone, the background will appear in red color.

The  trick  is  now  clear:  with  larger  user  terminals,  our  website  will  use  the
"stylesheet.css"file , while when sensing the presence of a smaller terminal our site
will  be  displayed  according  to  the  formatting  instructions  referenced  in
"stylesheet_smartphone.css".

Now let's see how and where to introduce changes in our "stylesheet_smartphone.css"
file to ensure proper visualisation on smartphones (first be sure to restore the code line
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in the sylesheet file to background: #0000AA;, so as to have a blue background
in all conditions - we implemented the red background as a mere example; if after
having restored the code line you still see a red background on your phone, reset its
cache memory and refresh your homepage once more).

What we are going to do is to display the whole site on a single column with a width
of 360 pixels (instead of displaying it on a 1366-pixel-width screen, as we did up to
now). We choose this smaller size among other possible sizes because we are using an
Android smartphone as a test platform featuring a screen of this specific width.  To
achieve the above, we will shrink the size of all the existing images that are too large
to fit the target column width. Furthermore, we will adapt the existing text blocks to
the smaller available width.

Let's  start shrinking the homepage's  cover image (its width is 1366 pixels,  we will
reduce this value to 360 pixels). In the "stylesheet_smartphone.css" file, look for the
code  chunk  named  #Cover_image,  delete  them  all  and  replace  them  with  the
following code:

The remaining part of Chapter 15,
Chapter 16 and Chapter 17 

are not included
in this preview
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A FINAL REMARK

We built  up our website.  By clicking www.mywebsite-atlast.orgfree.com you can
consider the offspring of our effort.

Please remember that "My website at last" is but an example: you are free to use the
code blocks we have defined together as if  they were a set of  building blocks,
which can be positioned according to  your specific  needs (by changing the values
embedded in them, such as positions,  colors,  widths,  fonts,  picture names, etc.)  to
create your personal website.

You  can  download  the  different  files  edited  in  this  ebook  for  www.mywebsite-
atlast.orgfree.com at the following hyperlinks (in PDF version):

• "index.html": click here
• "subpage.html": click here
• "stylesheet.css": click here
• "stylesheet_smartphone.css": click here

For  any  questions,  requests  of  information  or  suggestions,  write  to
michele.sanvico@italianwriter.it.

Don't forget to drop by at www.italianwriter.it!
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